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Preface

INTRODUCTION

Healthcare is constantly changing so our brand 
needs to evolve too, to better represent who we 
are today and where we’re going tomorrow. 

As we continue to evolve, it’s more important  
than ever to look and sound like one Elixir.  
Clients, members, prospects even competitors 
should have a consistent experience with us.  
It starts with each one of us learning and  
embracing our purpose, promise and the  
language we use to bring it to life.

USING THIS GUIDE

This guide documents how we can protect our company’s 
identity by ensuring the use of visual elements consistently and 
structuring all messages to reflect an accurate vision of Elixir. 
This document provides guidance for instances when many 
possibilities exist to communicate the Elixir brand and offers 
clarity to both users of and designers for the Elixir brand.

CONTACT

If you have questions regarding the correct usage of the Elixir 
brand, please contact: AskMarketing@elixirsolutions.com
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CONTACT

If you have questions regarding the correct usage of the 
Elixir brand, please contact: 

AskMarketing@elixirsolutions.com

USING THIS GUIDE

This guide documents how we can protect our company’s 
identity by ensuring the use of visual elements consistently 
and structuring all messages to reflect an accurate vision  
of Elixir. This document provides guidance for instances 
when many possibilities exist to communicate the Elixir 
brand and offers clarity to both users of and designers for 
the Elixir brand.

INTRODUCTION

Healthcare is constantly changing so our 
brand also needs to evolve, to better 
represent who we are today and where  
we’re going tomorrow. 

As we continue to develop, it’s more  
important than ever to look and sound  
like one Elixir. Clients, members, prospects 
even competitors should have a consistent 
experience with us. It starts with each one 
of us learning and embracing our purpose, 
promise and the language we use to bring  
it to life.
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WHY ELIXIR EXISTS

We exist to help companies of all sizes 
and types get what they want and need 
from their pharmacy benefits. They can 
rely on our expertise to accommodate 
their requests and trust that we will 
lead them to make sound decisions and 
deliver on our promises.

Guiding Principles

Elevating the 
pharmacy benefit 

experience

O U R  M I S S I O N
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Guiding Principles

Creating pharmacy benefits that work for you
O U R  P U R P O S E  A N D  B R A N D  P R O M I S E

WE DO THIS BY BEING:

Flexible and 
accommodating

Innovative  
and creative

Consultative  
and proactive 

Accountable  
and responsive Trustworthy

•	The enterprise scale to 
compete aggressively  
and the ability to craft  
unique solutions

•	System infrastructure to 
support tailored programs, 
integrate with vendors  
and alternative payers.

•	 In-house clinical 
expertise with solutions 
such as managed copay 
strategies, integrated 
medical/pharmacy, MTM, 
pain management, etc.

•	Unique enterprise 
programs only Elixir  
can provide.

•	Specialized account 
teams with segment 
experience

•	Proven ability to help 
plans grow

•	Commit to a 2-hour 
response time

•	Agree to contract terms 
and follow through

•	Clear contract terms 

•	Not affiliated with a 
health plan payer
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ELIXIR ELEVATOR SPEECH

Elixir is the pharmacy benefits people. We are pharmacy benefits done your way, to meet your plan  
design needs, satisfy program management objectives and achieve bottom-line cost goals.

We’re owned by Rite Aid, a Fortune 200 company and leading retail drug chain, not a health plan payer.  
This gives us the enterprise strength to compete with the organization to be a fully integrated pharmacy 
services provider.

As a full-service pharmacy benefit manager, Elixir owns and operates all of the capabilities and services  
to deliver the full pharmacy care experience. Our goal is to create pharmacy benefits that work for you.  
We work with you to craft client-driven innovation—clinical solutions that deliver a positive member 
experience and the desired outcomes. We use clear contract language and deliver on our promises. 

Our account teams are experienced professionals, dedicated to the market segments each serves.  
Your account team will guide you towards achieving your goals, whether that’s membership growth, 
optimizing drug spend, improving benefits or some combination of having it all.

If I had to sum up Elixir in just a few words, it would be responsive, innovative, and accommodating.  
The bottom line is Elixir is the reliable PBM. You can count on us.

Guiding Principles
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USE OF ELIXIR

When writing Elixir within copy, writers should always use title 
case; meaning capitalizing the E and the remaining letters should 
be lowercase. Elixir should always be spelled with a capital E even 
though it is lower case in the logo. For legal purposes only (e.g., 
proposals or contracts), the legal name is Elixir Rx Solutions, LLC. 
Otherwise, the company should only be represented in writing as 
Elixir. Do not use Elixir Rx, ElixirRx or Elixir Solutions. 

Guiding Principles

Elixir

C O R R E C T 
U S E

X  I N C O R R E C T  U S E

elixir Elixir Rx ElixirRx Elixir 
Solutions
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BRAND ARCHITECTURE - PHARMACY BENEFITS BRAND ARCHITECTURE - INSURANCE

Guiding Principles

WEBSITE:
elixirsolutions.com

WEBSITE:
elixirinsurance.com

LEGAL ENTITY LEGAL ENTITYMARKET-FACING MARKET-FACING

Elixir Rx Solutions, LLC Elixir Insurance  
Company

Elixir Savings, LLC

Elixir Pharmacy, LLC

Elixir Elixir Insurance
Elixir RxPlus
Elixir RxSecure

Elixir Savings

Elixir Pharmacy
Elixir Mail Order Pharmacy
Elixir Specialty Pharmacy

Insurance logo is external-facing only
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When defining a brand’s tone of voice, 
think of the company as a person.  
The person’s personality speaks loudly 
through their words and actions. 

In creating our brand, we have to be 
consistent in what we say and how we say 
it. This is what defines Elixir’s personality, 
brought to life through words. 

We have three simple guidelines  
for our brand voice: Accommodating; 
Expert yet uncomplicated; and 
Transparent and candid. 

By following these attributes, we become 
consistent, distinctive, and recognizable 
as a friendly advocate looking out for our 
clients’ and members’ best interests.

Elixir possesses the keys to make the 
pharmacy benefits experience better for 
everyone—clients and members alike. In 
our communications, if we focus on this 
purpose, we succeed in engaging our 
audiences and consistently represent our  
brand promise.

Guiding Principles

BRAND VOICE
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Our clients are frustrated with PBMs who 
answer ‘yes’ on RFPs only to find out they 
have a hidden agenda. Elixir is different. 
We want our clients to meet their goals 
and we will do whatever we can to get 
to yes and deliver on that promise. We 
care about their business and we are 

committed to delivering what they need. 
However, we aren’t order takers. We listen 
and we respond, often with advice or 
consultative input based on our expertise. 
Clients can think of us as a friend who 
is sincerely interested in seeing them 
succeed.

Guiding Principles

BRAND VOICE: ACCOMMODATING
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Guiding Principles

BRAND VOICE: ACCOMMODATING

Aligned with our clients’ goals

Collaborative

Focused on outcomes

Attentive and good listeners

Caring and dedicated

Warm, friendly

Empowering

X Feigning intent

X Corporate

X Rigid

X Unresponsive

X Just taking orders

W E  A R E : W E  A R E  N OT:
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Guiding Principles

BRAND VOICE: ACCOMMODATING

Because we own all the assets needed to 
optimize the full pharmacy care experience, 
you get control and choices.

We believe in lasting 
partnerships. We’re 
connected and 
collaborative and 
there’s nothing we 
can’t achieve together.

We always listen to 
understand, stay agile 
and adapt quickly, and 
represent our brand—
and yours—with pride.

We don’t like the high cost 
of specialty medications 
either. Here’s what we’re 
doing about it.

Elixir Specialty sees each specialty 
prescription as an opportunity to help 
improve a member’s condition and 
quality of life.
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Guiding Principles

BRAND VOICE: EXPERT YET UNCOMPLICATED

With over 20 years as a full service PBM, 
Elixir is not new to pharmacy benefits. Our 
clients can rely on us to help them better 
understand the nuances of a complicated 
industry. We do what we can to keep it 
simple. We use straightforward language 
in our contracts and communications. 
We don’t use jargon or terminology 
that only a pharmacist understands but 
rather common language that is easy to 
comprehend. We explain and provide 
insights from our expertise, allowing our 
clients to make informed decisions.

Likewise, our members are overwhelmed 
with med-speak. The entire healthcare 
industry bombards them at every turn with 
conflicting messages wound up in jargon 
and tiny print. Elixir is genuine with our 
members. We help them navigate their 
pharmacy benefits by using common 
language and explanations that are 
understandable. We aren’t condescending 
but rather helpful and human. We treat 
members like we would treat a friend.
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Guiding Principles

BRAND VOICE: EXPERT YET UNCOMPLICATED

Helpful, consultative, insightful

Approachable

Informative, using simple terms

Experienced

Thoughtful

Friendly

X Patronizing

X Arrogant

X Authoritative

W E  A R E : W E  A R E  N OT:
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Guiding Principles

BRAND VOICE: EXPERT YET UNCOMPLICATED

Step Therapy: Requires you to try an 
alternative drug prior to another for a particular 
diagnosis. The alternative drugs are safe and 
effective and usually less expensive.

Modeled after CDC guidelines 
and available to clients at no 
cost, our Pain Management 
solution ensures members get 
the medication they need with 
all safety precautions in mind.

Drugs you take on a 
regular basis, such as 
those for controlling 
diabetes or lowering 
cholesterol or blood 
pressure, are known  
as maintenance drugs.

With our EasyRefill program, 
refills are automatically sent 
so members never have to 
worry about missing a dose.

Sometimes high-cost prescription drugs 
have a lower cost alternative available 
that is proven to be safe and effective in 
treating the same condition.
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Guiding Principles

BRAND VOICE: TRANSPARENT AND CANDID

There’s a lot of talk about transparency  
in pharmacy benefits and everyone  
seems to have their own definition.  
At Elixir, transparency is clarity. Clients 
know what to expect with us, from pricing 
to service levels. We tell them the truth,  
good or bad, with sincerity. 

We own our missteps and we 
communicate with honesty. We don’t 
pretend to know it all but rather admit  
that together, we can figure it out. 
We share knowledge and we act as a 
consultant, advisor and advocate.
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Guiding Principles

BRAND VOICE: TRANSPARENT AND CANDID

Honest and straightforward

Sincere and open

Trustworthy, dependable  
    and reliable

Genuine

X Righteous

X Blunt or rude

X Hiding behind small print

X Inconsistent or vague

W E  A R E : W E  A R E  N OT:
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Guiding Principles

BRAND VOICE: TRANSPARENT AND CANDID

Elixir experienced a service interruption with 
our adjudication platform that prevented some 
claims from processing at point-of-sale. The 
issue causing the outage has been resolved, 
with claims now processing normally.

Our contract language is easy to understand, 
with straightforward definitions and exclusions. 
We’ll structure your contracts in the way that 
works best for you.

You can count on your 
Elixir account team 
to collaborate with 
you to support sales 
plans, client retention 
strategies, quarterly 
business reviews and 
more.

Your account team works 
with clients just like you, 
so they can offer solutions 
for the challenges you face 
everyday.

You can trust your account 
team to be responsive 
because we commit to a 
2-hour response time to all 
of our clients.
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Tone

The tone of our brand voice is approachable, conversational, simple. 

•	We talk about Elixir in the first person 
(I, we) and we address our clients and 
members in second person (you), rather 
than third person (he/she/it/them). 

•	We use the term ‘member’ or ‘consumer’ 
rather than patient. We use simple 
language and avoid jargon.

•	Use positive statements and 
compassionate language whenever 
possible.

•	Avoid language that creates a 
bureaucratic, clinical or impersonal tone.

•	Write in a conversational manner.

•	Avoid industry jargon and complicated 
terms. Write in simple language.

•	Be instructive (not assuming that the 
reader knows or remembers all the 
details, basics or rules).
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Tone

USE ACTIVE VOICE

Elixir communications should be written in active voice, unless it is discussing an 
event that is in the past. Active voice means a sentence has an object that performs 
the verb’s action.

As a reference, in passive voice, the subject is the recipient of the verb’s action. 

C O R R E C T  E X A M P L E X  I N C O R R E C T  E X A M P L E

“The company requires associates to 
take compliance training every year.” 

“The associates are required by the 
company to take compliance training 
every year.” 
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Tone

USE BENEFIT-ORIENTED LANGUAGE

Write for the perspective of the reader. How does the reader benefit from what you’re 
saying? Be clear and write for the reader’s benefit.

C O R R E C T  E X A M P L E X  I N C O R R E C T  E X A M P L E

“You can rely on us to work alongside 
you as an extension of your team.” 

“We work as an extension of your team.”
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Tone

1 4

2 5

3 6

MEMBER COMMUNICATIONS

Communications should be written at a tenth-grade level or lower, with an ultimate 
goal of sixth grade. Use Word to check the grade level:

Go to File → Options

Select Proofing

Under “When correcting spelling  
and grammar in Word,” make sure  
the “Check grammar with spelling” 
check box is selected 

Select “Show readability statistics”

Go to Review → Spelling & Grammar

Once you have corrected or ignored 
any spelling or grammar errors, a  
pop-up window will provide readability 
scores. The Flesch-Kincaid score 
provides the grade level.
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PREFERRED LANGUAGE FOR MEMBER COMMUNICATIONS

Referring to Elixir

•	Refer to Elixir as a pharmacy benefit manager

•	Elixir serves members by managing 
prescription drug benefits on behalf of clients

•	Elixir manages your prescription drug benefit 
on behalf of <Client Name>

How we help members

•	We are committed to helping you access the 
medications you need at prices you can afford.

•	We use tools that make it easier for you to  
make smart choices that save you money.

•	<Solution> saves you money with lower 
copayments and helps your plan continue to 
provide excellent coverage for you and your 
family.
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Tone

PREFERRED LANGUAGE FOR MEMBER COMMUNICATIONS continued

Accessing the Member Portal

•	Log into elixirsolutions.com by selecting REGISTER/
LOGIN. Have your member ID card handy and follow 
the instructions.

•	To use the mobile app, search Elixir Rx Solutions in 
your device’s App Store and download the app.

•	Avoid using “Member Portal” in member 
communications. Instead, say, “Log into Elixir to 
transfer prescriptions, view order history, etc.”

•	Note: Some clients still have a separate Mail Portal. You 
can say, “Log into Elixir to access home delivery options.”

Changing Medications

•	Always talk to your doctor before you 
change or stop taking any medication.  
If you have medical questions, please 
contact your healthcare provider.
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PREFERRED LANGUAGE FOR MEMBER COMMUNICATIONS continued

Generic/Preferred Alternatives

•	The majority of generic medications are covered under 
your plan and we encourage you to ask your doctor to 
prescribe generic drugs whenever appropriate.

•	There are one or more preferred alternatives available 
that are proven safe and effective in treating the same 
condition/s. Please ask your doctor to prescribe a 
preferred alternative medication.

•	If you are prescribed any of the excluded high-cost 
medications, talk to your doctor about changing to  
lower cost alternatives that are covered by your plan.

Contacting Customer Care

•	Have questions? Please call Elixir 
Customer Care at 800-361-4542  
(TTY 711), 24 hours a day, seven  
days a week.
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FREQUENTLY USED WORDS FOR MEMBER COMMUNICATIONS

Customer Care 
Use instead of customer service

Enroll 
Use for referring to signing up for  
mail order instead of register

Register 
Use to refer to accessing the Member Portal.  
Do not use when referring to signing up for mail order.

Member ID Card 
Use instead of prescription ID. Capitalize Member ID.

Member Portal 
Use “Log into Elixir” instead

Over the counter 
Spell out and hyphenate when preceding 
a noun. Can also use available without a 
prescription. Do not use OTC.
•	Example: 

That is an over-the-counter medication. 
That medication is available over the counter.

•	Not:
That is an over the counter medication.
That medication is available over-the-counter.

Preferred Drug List 
Use instead of formulary. Also can say 
‘approved drug list.’
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GENERAL MEMBER COMMUNICATIONS

Pharmacy Network 
Elixir has one of the industry’s largest 
pharmacy networks, with over 65,000 
pharmacies nationwide, including large retail 
chains, many local independent pharmacies, 
mail and specialty pharmacy options.

Elixir Customer Service Hours
Legacy EnvisionRx: 24 hours a day,  
seven days a week, 365 days a year

Legacy MedTrakRx: Monday – Friday 6 a.m.  
to 9 p.m. CT; Saturday 9 a.m. to 5 p.m. CT 

Elixir Pharmacy Hours 
Customer care representatives are available  
8 a.m. to 10 p.m. ET Monday through Friday 
and Saturday from 8 a.m. to 4:30 p.m. ET, with 
pharmacists available 24 hours a day, seven  
days a week.

Member communications should follow  
a review process that includes Legal  
and Compliance prior to distribution.

R E V I E W  P R O C E S S 
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Preface

INTRODUCTION

Healthcare is constantly changing so our brand 
needs to evolve too, to better represent who we 
are today and where we’re going tomorrow. 

As we continue to evolve, it’s more important  
than ever to look and sound like one Elixir.  
Clients, members, prospects even competitors 
should have a consistent experience with us.  
It starts with each one of us learning and  
embracing our purpose, promise and the  
language we use to bring it to life.

USING THIS GUIDE

This guide documents how we can protect our company’s 
identity by ensuring the use of visual elements consistently and 
structuring all messages to reflect an accurate vision of Elixir. 
This document provides guidance for instances when many 
possibilities exist to communicate the Elixir brand and offers 
clarity to both users of and designers for the Elixir brand.

CONTACT

If you have questions regarding the correct usage of the Elixir 
brand, please contact: AskMarketing@elixirsolutions.com
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LOGO

Consistent usage of our logo helps build 
recognition of our brand and ensures 
our logo is always rendered with proper 
impact and legibility. 

The Elixir logo is in Elixir Blue, Elixir Green 
with a gray tagline on a white background. 
This is our most universally recognized 
asset, and to aid comprehension, we use 
that version whenever possible. 

Download logos in the Elixir Asset Library.

https://erxo.workfrontdam.com/bp/#/folder/7895061/
https://erxo.workfrontdam.com/bp/#/folder/7895061/
https://erxo.workfrontdam.com/bp/#/folder/7895061/


3 2  /  E L I X I R  B R A N D  G U I D E L I N E S

PREFACE

TONE

ACRONYMS

GUIDING PRINCIPLES

WRITING STYLE GUIDE

PRIVACY MARKS

DIGITAL 

BRAND STANDARDS

FREQUENTLY USED WORDS

Brand Standards

LOGO COLOR OPTIONS

The white with green bubbles and white versions of the logo should be used only on 
approved brand colors and imagery where the logo is clear and unobstructed. 

The black logo option is approved for black and white print-only applications, 
newspaper advertising or forms.

WHITE WITH GREEN
Used on Elixir Blue, Elixir Navy or  

black background only.

WHITE 
Used on approved brand colors and imagery 

where logo is clear and unobstructed.

BLACK
Used on black and white print-only,  

newspaper advertising or forms. 
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LOGO TAGLINE USAGE

Use logo with “Crafted Rx Solutions” tagline for:
•	Front or back covers of internal documents    
such as presentations, brochures, letters etc.

•	Any external facing documents unless logo 
needs to be smaller than its minimum size   
(see page 35). 

Use logo without tagline for:
•	Documents where the logo is too small to use    
the tagline, such as the footer on presentation    
slides or word documents.

•	Internal documents such as forms and reports.
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LOGO CLEAR SPACE

The logo should have adequate space between it and nearby elements on the page. 
The space around the logo will vary by size of the layout. The minimum space around 
the logo is equal to the letter “x” from the logo.

CLEAR SPACE RULE WITH TAGLINE CLEAR SPACE RULE WITHOUT TAGLINE
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LOGO MINIMUM SIZE

To maintain legibility, the logo with tagline should scale down proportionally to no 
smaller than 1.2” wide and .55” high. The logo without tagline should scale down to  
no smaller than .78” wide and .28” high.  

 1 .2”

.78”

 .55”
 .28”

MINIMUM SIZE WITH TAGLINE
DIGITAL MINIMUM: 139.33X64 PIXELS

MINIMUM SIZE WITHOUT TAGLINE
DIGITAL MINIMUM: 144X48 PIXELS 
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IMPROPER LOGO USE

•	Don’t use white logo on light colors.

•	Don’t distort the logo in any way.

•	Don’t replace logo elements.

•	Don’t place the logo on unapproved 
colors, patterns or gradients.

•	Don’t apply any effects to the logo.

•	Don’t change the sizing or remove  
any logo elements.

•	Don’t apply any colors, patterns or 
gradients to the logo.

•	Don’t place color or black logos  
over images.

•	Don’t rotate or flip logo.

Crafted Rx Solutions

LOGO RESIZING TIP: Hold the shift key and grab the 
corner of the logo to resize proportionally.
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PRINT COLOR PALETTE - PRIMARY

Consistent use of color is one 
of the easiest ways to increase 
brand recognition. The Elixir brand 
is dominated by blue and green, 
utilizing accent colors and white 
space to create eye-catching 
layouts. Tints of the approved 
colors may be used.

ELIXIR BLUE
PMS 293C 

C=100 M=76 Y=0 K=9

R=0 G=61 B=166

TINTS: 75%/50%/25%

ELIXIR GREEN
PMS 376C 

C=50 M=0 Y=96 K=0

R=110 G=161 B=1

TINTS: 75%/50%/25%
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PRINT COLOR PALETTE - SECONDARY

PMS 715C 
C=0 M=50 Y=93 K=0

R=243 G=137 B=38

TINTS: 75%/50%/25%

PMS 576C 
C=48 M=6 Y=79 K=17

R=69 G=118 B=11

TINTS: 75%/50%/25%

PMS 295C 
C=100 M=63 Y=0 K=67

R=0 G=40 B=88

TINTS: 75%/50%/25%

PMS 326C 

C=81 M=0 Y=38 K=0

R=44 G=165 B=151

TINTS: 75%/50%/25%

PMS 2389C 

C=63 M=12 Y=0 K=0

R=61 G=148 B=206

TINTS: 75%/50%/25%

PMS 430C 

C=55 M=41 Y=38 K=5

R=22 G=27 B=30

TINTS: 75%/50%/25%

PMS 7416C 

C=0 M=69 Y=65 K=0

R=225 G=102 B=81

TINTS: 75%/50%/25%

PMS 635C
C=32 M=0 Y=1 K=0

R=166 G=223 B=246

TINTS: 75%/50%/25%
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ACCESSIBLE COLOR PALETTE - PRIMARY

Color contrast is very important 
to legibility. To meet current 
accessibility standards, use only 
approved color combinations for 
electronic documents and web 
pages. Be sure to take special  
care with reverse type and type 
overlays for maximum readability.

HEX: 003DA6 HEX: 6EA101

Blue can be used as text at any size or as  
backgrounds with any size white text. 

Green can be used as bold 14pt+ text,   
background with white 14pt+ bold text  
or background with dark text such as  
black or navy.

ELIXIR GREEN
14PT+ BOLD & 

WHITE REVERSE 
DARK REVERSE

ELIXIR BLUE
PASS
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ACCESSIBLE COLOR PALETTE - SECONDARY, TERTIARY AND GRAYSCALE

MED GREY 2
14PT+ BOLD & 

WHITE REVERSE 
DARK REVERSE

LIGHT GRAY
DARK REVERSE

HEX: 002858

HEX: 3D94CE

HEX: 353C3E

HEX: 45760B

HEX: A6DFF6

HEX: 676E71

HEX: 1C8172

HEX: 2CA597

HEX: 8F9699

HEX: 3E7BA4

HEX: F38926

HEX: D2DADD

HEX: 6A4182

HEX: E16651

HEX: F0F3F4

These colors can be used as text at 
any size or as backgrounds with any 
size white text.

All colors can be used as backgrounds with 
dark reversed text such as black  
or navy. 

*Med blue, light teal and coral can be used 
as bold 14pt+ text and as backgrounds with 
bold 14pt+ text.

SE
C

O
N

D
A

RY
DARK GREEN

PASS

DARK GRAY 2
PASS

DARK GRAY 1
PASS

LIGHT BLUE*
DARK REVERSE

DARK BLUE
PASS

MED BLUE*
14PT+ BOLD & 

WHITE REVERSE 
DARK REVERSE

ORANGE 
DARK REVERSE

NAVY
PASS

MED GREY 1
DARK REVERSE

TE
RT

IA
RY

G
RA

YS
C

A
LE

DARK TEAL
PASS

PURPLE
PASS

LIGHT TEAL
14PT+ BOLD & 

WHITE REVERSE 
DARK REVERSE

CORAL*
14PT+ BOLD & 

WHITE REVERSE 
DARK REVERSE
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TYPEFACE

Marketing and Digital Use: 
PROXIMA NOVA
Proxima Nova is an Adobe 
Typekit font that combines 
modern proportions with a 
geometric appearance. It 
is used for collateral, web 
and other external-facing 
marketing items. This is not 
an available system font 
and is limited to use by the 
Marketing department.

PROXIMA NOVA
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcedfghijklmnopqrstuvwxyz
1234567890!@#$%^&*()[]

TYPEFACE WEIGHTS USED
Proxima Nova Regular
Proxima Nova Medium
Proxima Nova Semibold
Proxima Nova Bold

Proxima Nova Italic
Proxima Nova Medium Italic
Proxima Nova Semibold Italic
Proxima Nova Bold Italic
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TYPEFACE

Corporate Use:  
FRANKLIN GOTHIC DEMI  
AND ARIAL NARROW
Use these fonts for letters, 
emails, presentations and 
reports. These are system 
fonts and should be readily 
available for use. 

FRANKLIN GOTHIC DEMI
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcedfghijklmnopqrstuvwxyz
1234567890!@#$%^&*()[]
Used for titles, larger numbers and callouts - one weight

ARIAL NARROW 
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcedfghijklmnopqrstuvwxyz
1234567890!@#$%^&*()[]
Used for body copy and copyright - regular and bold weights
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TYPEFACE GUIDELINES

To reinforce clarity and consistency in our 
design, please follow these general guidelines. 

Size Minimums: The minimum font size should 
be no smaller than 7 pt. for legibility, including 
fine print. This excludes Elixir’s copyright and 
date boilerplate information, which should be 
no smaller than 6 pt., if needed.
Any communications or marketing materials to 
be sent to a Medicare beneficiary must be in  
12 pt or larger typeface.

Alignment: Left align is preferred. Right and 
center align should be used only when required 
by the design. 

Kerning and tracking: In Adobe applications, 
kerning should always be set to optical and 
tracking should never be set to less than -10. 
Above 10 is used sparingly for callouts. 

Headlines and subheads: You can use 
sentence case (Lorem ipsum) or all-caps 
(LOREM IPSUM)

Intro copy, body text and legal disclaimers: 
Should always be in sentence case (Lorem 
ipsum).
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PHOTOGRAPHY

Our photographic style demonstrate people in their daily lives achieving whole health.

Look for:

•	Real, relatable and diverse people 
engaged in everyday activities or 
spontaneous moments

•	Warm, natural lighting 

•	Has depth, not a flat photo

•	One natural focal point (looking at 
the camera is okay if not staged)

Refrain from using: 

•	People pointing 

•	Staged scenes, models or cliché 
scenarios (people walking on the beach) 

•	Dark lighting

•	Unrealistic or unattainable situations 
(mansion-like homes)
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PHOTOGRAPHY EXAMPLES

Download photography 
to use in the Elixir 
PowerPoint template

http://elixir.info/photography
https://elixir.info/ppttemplate
http://elixir.info/photography
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ICONOGRAPHY

Icons are selectively used in 
larger documents, websites and 
presentations where we are trying 
to communicate a message and/
or call-to-action quickly by using a 
more visual cue. There are a wide 
variety of icon options to select from 
in the Elixir PowerPoint template. 
If you need an icon that is not in 
the document, please contact 
AskMarketing@elixirsolutions.com.

Icon Best Practices
•	Our icon style has a stroke or outline color instead  

of a filled color. 

•	When working with icons in PowerPoint, control the 
color and width by right clicking the icon and select 
FORMAT SHAPE to open the menu. 

•	Keep the outline thickness 2 pt width for smaller 
icons and 4.5 pt width for larger icons.

•	To change colors, change the SHAPE OUTLINE color. 
Note: There are a couple icons that include filled 
shapes such as an Rx. Double click on the filled 
shape to select just that shape and apply the fill 
color to match the color of the outline. 

https://elixir.info/ppttemplate
mailto:AskMarketing%40elixirsolutions.com?subject=Icons
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ICONOGRAPHY EXAMPLES

Find icons in the Elixir  
PowerPoint template

http://elixir.info/ppttemplate
http://elixir.info/ppttemplate
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TEMPLATES

Standard communication materials are 
available to support Elixir across the 
organization. The Elixir template toolkit 
is available in the Elixir Asset Library for 
downloading. 

Assets included in the template toolkit:

•	Logos

•	Letterhead with cover page

•	Presentations with integrated color 
and design standards

•	Email signature 

•	Fax cover sheet

•	SOP (Standard Operating Procedure) 

•	General Word document

Download all materials from  
the Elixir Asset Library

https://elixir.info/library-templates
https://erxo.workfrontdam.com/bp/#/folder/9571528/
https://erxo.workfrontdam.com/bp/#/folder/9571528/
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LETTERHEAD TEMPLATES

•	8.5 x 11 letter size

•	Font: Arial Narrow

•	Pre-saved information has already been 
loaded into the standard letterhead 
templates

•	Confidential, restricted and no privacy  
mark choices

•	Letterhead with cover page also available

 
 
 

800-361-4542 | elixirsolutions.com Confidential – Do not copy or distribute. 

Sample Letter 
 
Date 
  
Name 
Company  
Address 
City, State Zip Code 
 
 
Dear Name, 
 
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Vestibulum non quam eu enim congue aliquet ut tempor nisl. 
Aenean maximus molestie erat eget malesuada. Pellentesque habitant morbi tristique senectus et netus et 
malesuada fames ac turpis egestas:  
 

• Dolor sit amet, consectetur adipiscing elit  
• Aenean maximus molestie erat eget malesuada  
• Pellentesque habitant morbi tristique 

 
Aenean malesuada, justo sit amet porta vulputate, nisi nisi imperdiet sapien, at ultricies magna mi ut nisi. Aliquam 
mattis varius maximus. Phasellus hendrerit rhoncus nisi, vel lacinia odio lacinia sed. Maecenas porta mollis lectus, 
dignissim condimentum augue. 
 
Vestibulum non quam eu enim congue aliquet ut tempor nisl. Aenean maximus molestie erat eget malesuada. 
 
 
Sincerely, 
 
Name 
Company 
Contact Information 
URL 
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POWERPOINT PRESENTATION TEMPLATES

•	Format: PowerPoint Widescreen (16:9)

•	Customized template with instructions, 
colors, icons and photography 

•	Many layout design options to make 
building slides easier



5 1  /  E L I X I R  B R A N D  G U I D E L I N E S

PREFACE

TONE

ACRONYMS

GUIDING PRINCIPLES

WRITING STYLE GUIDE

PRIVACY MARKS

DIGITAL 

BRAND STANDARDS

FREQUENTLY USED WORDS

Brand Standards

POWERPOINT PRESENTATION TEMPLATES

Presentation Best Practices

•	Teach something new: incorporate 
underappreciated insights.

•	Think like a movie: use interesting visuals 
and keep track of time, not the number of 
slides.

•	Tell a story: use short phrases as slide titles 
to emphasize the most important point you 
want to get across to the audience.

•	Keep it simple: slides should 
have plenty of white space; the 
less clutter, unnecessary words 
and bullets the better to minimize 
distractions. People can’t read and 
listen at the same time. 

•	Create a consistent look and feel: 
use the templates to unify your story 
using the same typography, colors 
and imagery across all slides. 
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EMAIL SIGNATURE TEMPLATE

•	Instructions included in the email signature file 
in the Elixir Asset Library.  

•	Follow all steps to maintain consistency 
throughout the company. Do not add any 
additional information in your email signature 
unless directed by Marketing.

•	For greater productivity, use the same 
information in your REPLY signature or at least 
include your phone number(s).

•	Double check the quality of the logo. It should 
be clear and not pixelated.

 

Email Signature & Default Font in Microsoft Outlook 
 
 
1. Create your new email signature: 
 
Go to File -> Options -> Mail -> Signatures  
 
Edit your current signature or click ‘New’ to create a new one, then copy the entire information below and paste into 
the box under ‘Edit Signature’. Edit your full name and any designations, your title, phone and fax numbers and your 
email address. Do not just copy the logo. Do not add any additional information in your email signature unless 
directed by Marketing. 
 
 
 
Name, Designation (i.e. PharmD, R.Ph., etc.) 
Title 
W 555-555-5555 | M 555-555-5555 | F 555-555-5555 (optional)  
name@elixirsolutions.com 

 
 
 
 
 
 
 
2. Change the default font for emails to Arial Narrow: 

 
Go to File -> Options -> Mail -> Stationery & Fonts 
 
Set both ‘New Mail Message’ and ‘Replying & Forwarding Message’ to Arial Narrow, Pt size 11. 
 
 
 
 
 
 
 
 
  

https://elixir.webdamdb.com/bp/#/folder/10203908/127406189
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© 2023 Elixir Rx Solutions, LLC - All Rights Reserved.  

 
SAML Encryption and Signing: 

Encryption:  
Elixir can handle encrypted and non-encrypted SAML assertions. Elixir’s public key cert will be provided in the event 
it is required for SAML assertion encryption. 

XML Signing: 
Elixir will require a public key cert from Highmark to verify signature in Test Environment and Production 

Target URLs: 
Test Environment: https://sso-uat.elixirsolutions.com/SSOAuthentication/SSOAuth?Client=Highmark 
Production: https://sso.elixirsolutions.com/SSOAuthentication/SSOAuth?Client=Highmark 

Required SAML 2.0 Attributes: 
• Attribute name: ClientId  

Attribute value: 38cdd2e7-62cc-4b4f-bcbc-896bb334faeb 
Format: string  
Description: Client identifier, assigned by Elixir 

• Attribute name: MemberID 
Format: string  
Description: The Member ID of the User 

• Attribute name: FirstName 
Format: string 
Description: The First Name of the User 

• Attribute name: LastName  
Format: string 
Description: The Last Name of the User 

• Attribute name: DOB  
Format: string (MMddyyyy ex. 12231997) 
Description: Date of Birth of the User 

Optional Attributes: 
• Attribute name: SSOHost  

Format: string (URL) 
Description: When the user logs out, they will be redirected to the URL provided in this attribute.  

• Attribute name: ErrorRedirect 
Format: string (URL) 
Description: When there is an SSO error, the user will be redirected to the URL provided in this attribute. 

 
 
 

800-361-4542 | elixirsolutions.com Confidential – Do not copy or distribute. 

 
Standard Operating Procedure 
 
SOP Number and Title (EX: CE-SOP-A Credentialing Workflow Process) 
Key Points 

• The first key point defines which entities/departments and/or job titles this SOP applies to. 
EXAMPLE: This Standard Operating Procedure applies to Elixir and all of its wholly-owned 
entities (“Elixir”) including all Elixir employees, and, where appropriate, Covered Personsi. 

• The second point states any P&Ps or SOPs that are related to this document (if applicable). 

• The third [and additional] point(s) describe(s) the purpose or scope of this SOP. This is a concise 
summary of the objectives and provides information covered in the document. 

 
Standard Operating Procedure 
 
1. Section Title. Detail the procedure used for this SOPii. 

1.1. Use paragraph numbering to break the procedure into easy-to-follow sections. 
1.2. Use job titles (as opposed to specific employee names) to explain who is responsible for tasks described. 

 
Resources  

• Add relevant legal or regulatory citations.  
• EX: Center for Medicare and Medicare Services, “Prescription Drug Benefit Manual Chapter 9 - Compliance 

Program Guidelines”, last revision date 1-11-2013 
• URAC Accreditation Manual 

 
 

1 Covered Persons are others who provide services to or on behalf of Elixir. 
2 Use endnotes for definitions of industry terms not commonly known to the reader. This allows the reader to approach the content in a more knowledgeable 
manner and to easily refer back to the definition as needed. 
 
 
 
 
 
 
 
 
 

P&P Number and Title (EX: CE-01 Compliance and Ethics Program) 
Owner: Owner Department (EX: Compliance and Ethics) 
 
Uncontrolled document-printed version only reliable for 24 hours. 

Issued: XX/XX/XXXX 
Reviewed: XX/XX/XXXX  

Revised: XX/XX/XXXX 
Page 1 of 1 

 

Brand Standards

OTHER TEMPLATES

Fax Cover Sheet SOP Word Document

7835 Freedom Avenue NW 
North Canton, OH 44720 
Phone: 1-800-361-4542 
Fax: 1-330-405-8081 
elixirsolutions.com 

Fax 
To: 

[Name] 
Fax: 

[Fax Number] 
From: 

[Name] 
Date: 

[Select Date] 
Re: 

[Subject] 
Pages: 

[Number of Pages] 
Cc: 

[Name] 
 

 
 
☒ Urgent ☐ For Review ☐ Please Comment ☐ Please Reply ☐ Please Recycle 

 

Comments:  [Start text here.] 

Privacy & Confidentiality of Information Notice: This communication may contain non-public, confidential, or legally privileged information intended for the 
sole use of the designated recipients. If you are not the intended recipient, or have received this communication in error, please notify the sender immediately 
by reply email or by telephone at 800-361-4542, and delete all copies of this communication, including attachments, without reading them or saving them to 
disk. If you are the intended recipient, you must secure the contents in accordance with all applicable state or federal requirements related to the privacy and 
confidentiality of information, including the HIPAA Privacy guidelines. 
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Brand Standards

DIGITAL BUSINESS CARDS

Market-facing roles may request business 
cards by completing this form. You will 
receive an activation email within 48 hours 
from Haystack. Other requests may be 
granted on a case-by-case basis. 

For more information and to get started, 
visit our business card asset library folder. 
Request a digital card here.

Why digital business cards? Apart from 
saving some trees, our digital business cards: 

•	Look beautiful, modern and fresh;

•	Can easily be shared to anyone directly  
from your phone;

•	Facilitate ‘contactless exchange’ for 
maintaining social distancing;

•	Can be shared to any device - no app install 
or sign-up is required by recipients;

•	Allow you to add paper business cards you 
receive by just snapping a photo of their 
card, and the app will automatically save  
the new contact details to your phone.

mailto:https://app.smartsheet.com/b/form/b540eefe6dfb4269b5504c693391ac32?subject=
https://elixir.info/digitalbusinesscards
https://app.smartsheet.com/b/form/b540eefe6dfb4269b5504c693391ac32
https://elixir.info/digitalbusinesscards
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Brand Standards

ENVELOPES

•	Full color and black & white options 
available in a variety of sizes, types and 
return addresses. 

•	If there is a need for envelopes, specific 
department designees will have access to 
online ordering. 

•	Contact AskMarketing@elixirsolutions.com 
if you need assistance. 

7835 Freedom Avenue NW 
North Canton, OH 44720

7835 Freedom Avenue NW 
North Canton, OH 44720

mailto:AskMarketing%40elixirsolutions.com?subject=Envelopes
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Preface

INTRODUCTION

Healthcare is constantly changing so our brand 
needs to evolve too, to better represent who we 
are today and where we’re going tomorrow. 

As we continue to evolve, it’s more important  
than ever to look and sound like one Elixir.  
Clients, members, prospects even competitors 
should have a consistent experience with us.  
It starts with each one of us learning and  
embracing our purpose, promise and the  
language we use to bring it to life.

USING THIS GUIDE

This guide documents how we can protect our company’s 
identity by ensuring the use of visual elements consistently and 
structuring all messages to reflect an accurate vision of Elixir. 
This document provides guidance for instances when many 
possibilities exist to communicate the Elixir brand and offers 
clarity to both users of and designers for the Elixir brand.

CONTACT

If you have questions regarding the correct usage of the Elixir 
brand, please contact: AskMarketing@elixirsolutions.com
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E L I X I R  B R A N D  G U I D E L I N E S

Writing Style Guide

mailto:askmarketing%40elixirsolutions.com?subject=
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Elixir follows AP Style unless otherwise 
denoted in this guide. The AP Style Book 
can be accessed online for additional 
information:

Writing Style Guide

https://www.apstylebook.com/

AskMarketing@elixirsolutions.com

Marketing2112

U S E R N A M E :

PA S S W O R D :

https://www.apstylebook.com/
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Do not use abbreviations in Elixir communications 
pieces, except for commonly used words like etc. 
instead of etcetera and U.S. instead of United 
States. When using abbreviations, put a period at 
the end (etc.) and with United States, use periods 
after the U and the S (U.S.).

Drug doses, such as milligram, should be 
abbreviated with a space between the number  
and the dosage. A period is not needed.

Writing Style Guide

ABBREVIATIONS AND ACRONYMS

C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E

10 mg

10mg
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When using acronyms, spell out the complete term 
the first time and put the acronym in parenthesis.

After this first use, you can use the acronym going 
forward. URAC is the exception to this rule. Never 
spell out the full name of URAC, always use URAC. 
See appendix for commonly used acronyms.

Writing Style Guide

ABBREVIATIONS AND ACRONYMS

C O R R E C T  E X A M P L E S :

Multiple sclerosis (MS)

Food and Drug  
Administration (FDA)

National Committee for  
Quality Assurance (NCQA)
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X  I N C O R R E C T  E X A M P L E

She has a bachelor of science.

If you’re using the full name of the degree, it’s capitalized (i.e., Bachelor of Science).  
If you’re not using the full name of the degree, it’s lower case (i.e., bachelor’s degree).

Writing Style Guide

ACADEMIC DEGREES

C O R R E C T  E X A M P L E

She has a Bachelor of Science. 

C O R R E C T  E X A M P L E

He has a bachelor’s degree. 

X  I N C O R R E C T  E X A M P L E

He has a Bachelor’s Degree.
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This is how we talk about our accreditations. You can learn more about these 
accreditations on our website here:  
https://www.elixirsolutions.com/aboutus/commitment-to-quality

RELY ON OUR COMMITMENT TO QUALITY 

Elixir holds multiple URAC accreditations, as well as several from the National  
Committee for Quality Assurance (NCQA), Accreditation Commission for Health  
Care (ACHC) and National Association of Boards of Pharmacy (NABP).

Writing Style Guide

ACCREDITATIONS

https://www.elixirsolutions.com/aboutus/commitment-to-quality
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Do not use the ampersand, or and sign (&), in sentences. It is acceptable to use it in 
headlines/subheads, in tables or when there are space constraints.

Writing Style Guide

AMPERSAND
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Capitalize the first letter in all bullet points. 
Only use periods with bullet points if it’s 
a complete sentence. Bullet points are 
normally lists and the points cannot stand 
alone as a sentence. If the point can stand 
alone as a sentence or has more than one 
sentence, use punctuation accordingly. If 
you use punctuation for one bullet, use it 
for all bullets in the list for consistency. 

Bullet points should be consistent within 
a list, however, they do not need to be 
consistent throughout a document. If 
within a document you have one bulleted 
list that uses complete sentences and 
then another bulleted list that is one or 
two words, not a complete sentence, do 
not add periods to the end of the latter’s 
bullet points. 

Writing Style Guide

BULLET POINTS
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Writing Style Guide

BULLET POINTS
C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E X  I N C O R R E C T  E X A M P L E

To find a pharmacy near you:
•	Visit elixirsolutions.com
•	Click on locate pharmacy
•	Enter your zip code

To find a pharmacy near you:
•	Visit elixirsolutions.com.
•	Click on locate pharmacy.
•	Enter your zip code.

To find a pharmacy near you:
•	visit elixirsolutions.com.
•	click on locate pharmacy.
•	enter your zip code.
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BULLET POINTS

C O R R E C T  E X A M P L E X  I N C O R R E C T  E X A M P L E

To transfer your prescription:

•	Ask your doctor to send a new 90-day 
prescription to us using the NCPDP number 
36-77361.

•	Call 866-909-5170 and Elixir Pharmacy 
will help you transfer your prescription. 
Representatives are available 24 hours  
daily. Some weekend hours may result in  
a call back from a pharmacy representative.

•	Mail your new 90-day prescription to us with 
the enrollment form included with the packet.

To transfer your prescription:

•	Ask your doctor to send a new 90-day 
prescription to us using the NCPDP number  
36-77361

•	Call 866-909-5170 and Elixir Pharmacy will  
help you transfer your prescription. 
Representatives are available 24 hours daily. 
Some weekend hours may result in a call  
back from a pharmacy representative.

•	Mail your new 90-day prescription to us with  
the enrollment form included with the packet
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Capitalization should be used at the beginning of sentences, known as sentence  
case, and for proper names. Be consistent with capitalization and do not capitalize  
random words.

Writing Style Guide

CAPITALIZATION

Headlines and Subheads 
Headlines and subheads should 
be in title case or initial caps. Title 
case or initial caps capitalizes the 
first letter of every word, except for 
conjunctions and prepositions  
(a, an, the, of) unless they are the 
first word in the headline/subhead. 

C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E

Taking the Sting Out of Treatment for 
Anemia of Chronic Kidney Disease 

Taking The Sting Out Of Treatment For 
Anemia Of Chronic Kidney Disease
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CAPITALIZATION

Job Titles 
Job titles are only capitalized if they come before a person’s name or in a signature.

C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E

Clinical Pharmacist Elizabeth Gooking Greenleaf 

Elizabeth Gooking Greenleaf, clinical pharmacist
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CAPITALIZATION

Elixir-Specific Roles 
Elixir-specific roles that are used to describe a service we provide should be capitalized; 
however, when used as a person’s title, the rules described above still apply (only 
capitalize when the title comes before the person’s name). Please note the credentials 
for these roles should not be capitalized. 

C O R R E C T  E X A M P L E S : X  I N C O R R E C T  E X A M P L E S :

Our specially trained Care Navigators provide 
personalized outreach to identified members.

Our specially trained care navigators provide 
personalized outreach to identified members.

Our Care Navigators are pharmacists and registered nurses. Our Care Navigators are Pharmacists and Registered Nurses.

Care Navigator Jane Doe Jane Doe, care navigator

If you have any questions, contact Customer Care. If you have any questions, contact customer care.
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Writing Style Guide

CAPITALIZATION

Diseases and Medical Conditions 
Do not capitalize a disease or medical condition unless it is a proper name or is at the  
start of a sentence. For conditions, such as hepatitis that have a letter denoting the type, 
only capitalize the letter indicating the type.

C O R R E C T  E X A M P L E C O R R E C T  E X A M P L E C O R R E C T  E X A M P L E C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E X  I N C O R R E C T  E X A M P L E X  I N C O R R E C T  E X A M P L E X  I N C O R R E C T  E X A M P L E

arthritis multiple sclerosis hepatitis C Crohn’s disease 

Arthritis Multiple Sclerosis Hepatitis C crohn’s disease or  
Crohn’s Disease
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Use endnotes for references and citations. The number denoting the endnote reference 
should be outside the punctuation for the sentence. References should be written as follows:

We recommend always including a website link, if possible, so the citation can be verified.
EXAMPLE Rosenthal, M (2023). Orphan Drugs Continue to Dominate Specialty Pipeline.  
Specialty Pharmacy Continuum, accessed at https://www.specialtypharmacycontinuum.com/Policy/
Article/02-23/Orphan-Drugs-Continue-to-Dominate-Specialty-Pipeline/69465.

If there are a lot of authors, you can use et al after listing the first one or two authors 
instead of listing each one.
EXAMPLE Cubanski, J., et al (2019). How Does Prescription Drug Spending and Use Compare Across 
Large Employer Plans, Medicare Part D, and Medicaid? Kaiser Family Foundation.

Author last name, first initial (year). Title of Article in Initial Caps. Name of Publication 
or Organization, Any other info like volume, pages, website link, etc.

Writing Style Guide

CITATIONS AND REFERENCES
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Spell out the names of states, such as Ohio, unless there are space restrictions, such as 
in a table. Always use a comma between a city and the state.

Writing Style Guide

CITIES AND STATES
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COLONS AND SEMICOLONS

The most frequent use of colons is at the end of sentences to introduce a list, 
tabulations, quote or something of emphasis. Only capitalize the first word after  
a colon if it is a proper noun, the start of a complete sentence or a bullet point.

C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E

There were three considerations: expense, time and feasibility.

There were three considerations: Expense, time and feasibility.
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COLONS AND SEMICOLONS continued

Semicolons are used to link independent clauses and/or to separate elements of 
a series when items in the series are long or contain commas. In general, use the 
semicolon to indicate a greater separation of thought and information than a comma 
can convey, but less than the separation that a period implies.

C O R R E C T  E X A M P L E

They pulled their boats from the water, sandbagged the  
retaining walls and boarded up the windows; but even with  
these precautions, the island was hard hit by the hurricane.
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X  I N C O R R E C T  E X A M P L E

I went to the store for milk, eggs, and bread.

Writing Style Guide

COMMAS

We do not use the Oxford comma. This means we do not use a comma before “and” or 
“or” in a series, unless the item in the series includes “and” or “or.”

C O R R E C T  E X A M P L E

I went to the store for milk, eggs and bread.

C O R R E C T  E X A M P L E

The sandwich choices are turkey, peanut  
butter and jelly, or grilled cheese.

X  I N C O R R E C T  E X A M P L E

The sandwich choices are turkey, peanut  
butter and jelly or grilled cheese.

For reference, the Oxford comma uses a comma before “and” or “or” in a series.
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Writing Style Guide

CREDENTIALS

Include acronyms for a person’s credentials 
with a comma after their name and use 
periods between the letters. If a person 
has multiple credentials, use a comma to 
separate the acronyms. Exceptions to the 
periods are primary and secondary degrees 
(BA, BS, MBA) and certifications where the 
certifying bodies do not use periods  
(BCACP, CSP, APR).

C O R R E C T  E X A M P L E S

Clark Kent, Pharm.D., BCACP 

Harry Potter, M.D. 

Minnie Mouse, R.Ph.
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Writing Style Guide

DASHES

Em Dash: The em dash is used for 
emphasis and is a longer dash. Use the 
“insert symbol” function in Word to select 
the em dash, or type two dashes and the 
next word to create one automatically. 
There is no space before nor after the  
em dash.

En Dash: The en dash is used between 
numbers, dates and times. It is slightly 
longer than a hyphen, but shorter than 
the em dash. Use the insert symbol in 
Word to select the en dash.

E M  DA S H  C O R R E C T  E X A M P L E

E N  DA S H  C O R R E C T  E X A M P L E

Elixir Insurance offers the lowest monthly 
premium—just $12.60—in several states.

The conference will be  
January 24–25, 2018. 
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Brand name drugs should always be 
capitalized. A registration mark should 
be used at the end of brand name drugs 
on the first reference only. After the first 
reference, the registration mark should 
not be used. Registration marks should 
be superscript.

Generic drugs should be lower case 
unless the drug appears in a headline 
or subhead. Generic drugs do not need 
registration marks.

Writing Style Guide

DRUG NAMES

Lyrica® insulinlyrica Insulin

C O R R E C T  
E X A M P L E

C O R R E C T  
E X A M P L E

X  I N C O R R E C T  
E X A M P L E

X  I N C O R R E C T  
E X A M P L E
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Use when two or more words 
come before a noun and describe 
it, unless the first word ends in “ly.” 

A hyphen should also be used 
when a word contains two vowels 
next to each other.

Writing Style Guide

HYPHENS

C O R R E C T  E X A M P L E

C O R R E C T  E X A M P L E

C O R R E C T  E X A M P L E S

X  I N C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E

high-cost conditions

highly rated  
television show

co-insurance  |  anti-inflammatory

high cost conditions

highly-rated  
television show
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EXAMPLES

e.g. vs. i.e. e.g. stands for exempli gratia 
and means “for example.” i.e. stands 
for id est and means “in other words.” 
To help keep the differences straight, 
you can associate the “e” in e.g. with 
example. E.g. should be used when 
providing a list of examples, whereas  
i.e. provides further explanation.

For both e.g. and i.e., always lower case 
both letters and put a period after each 
letter. Also, use a comma at the end 
before providing your list or explanation.

E . G .  C O R R E C T  E X A M P L E

I . E .  C O R R E C T  E X A M P L E

I like citrus fruits, e.g., tangerines,  
lemons and limes.

I like citrus fruits, i.e., the juicy, edible  
fruits with leathery, aromatic rinds.
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NUMBERS

Spell out numbers zero through nine and use numerals for all other numbers greater 
than nine, unless it’s at the start of a sentence. 

C O R R E C T  E X A M P L E X  I N C O R R E C T  E X A M P L E

C O R R E C T  E X A M P L E

There are 10 patients who take 
two medications each.

Forty people were on the train. 40 people were on the train.

X  I N C O R R E C T  E X A M P L E S

There are ten patients who take two medications each.  
or There are 10 patients who take 2 medications each.

Spell out any numbers that start a sentence. 
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He was in 1st place

Writing Style Guide

NUMBERS continued

C O R R E C T  E X A M P L E

1,000, 100,000, 200,000

This includes ordinal numbers.Use commas when there are 
more than three places.

C O R R E C T  E X A M P L E

He was in first place.

C O R R E C T  E X A M P L E

He was in 10th place.

X  I N C O R R E C T  E X A M P L E

He was in tenth place.
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NUMBERS continued

C O R R E C T  E X A M P L E S

C O R R E C T  E X A M P L E S

X  I N C O R R E C T  E X A M P L E

1K, 100K, 200K

1 million, 250 million, 3.5 billion
OR 1M, 250M, 3.5B 

one (1)

You can also use an upper case “K” to denote a thousand. 
There should not be a space between the number and the 
letter. Be consistent throughout the document in how you 
write numbers over a thousand. 

For numbers in the millions, billions or higher, use a 
numeral followed by the word millions, billions, etc. or an 
upper case “M” or “B,” etc. without a space between the 
number and the letter. Again, be consistent throughout  
the document.  

Do not spell out a number and then put the numeral in 
parenthesis.
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DATES

Use numbers in dates, do not spell out the day or year. Do not use st, nd, rd or th.  
Use a comma between the day and year.

C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E S

July 2, 2020 

July 2nd 2020 or July second 2020
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TIME

Use figures except for noon and 
midnight. Use a colon to separate hours 
from minutes when it’s not on the hour. 
To denote time, use lower case a.m. and 
p.m. with periods after each letter. There 
should be a space between the number 
and the designation. If a time zone is 
needed, capitalize the abbreviation for 
the time zone and do not separate the 
letters with periods. Also, do not put a 
comma before the time zone.

C O R R E C T  E X A M P L E

C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E

1 p.m. ET 

11:30 a.m. 

1:00 PM E.T. 

11:30AM, E.T.
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PHONE NUMBERS

Use dashes between the area code and prefix, not dots or parentheses, and do not 
include a 1 in front of the number, even 800 numbers.

C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E

330-486-4856 

1 (330) 486.4856
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PERCENTAGES

Use the percent sign (%) throughout document instead of spelling out percent.

C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E

54%

54 percent
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PARENTHESES

Use parentheses sparingly. Place a period outside the parenthesis if it is not a complete 
sentence and inside the parenthesis if is an independent sentence.

C O R R E C T  E X A M P L E C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E X  I N C O R R E C T  E X A M P L E

(as an example). (She used an example to make her point.) 

(as an example.) (she used an example to make her point).
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PRONOUNS

Use ‘he’ for singular in the first instance and ‘she’ for the second, if applicable, so that all 
genders are equally recognized.
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QUOTATION MARKS

All punctuation goes inside the quotation marks.

C O R R E C T  E X A M P L E

X  I N C O R R E C T  E X A M P L E

“I love my job!”

“I love my job”!
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SPACING BETWEEN SENTENCES

Always use a single space between sentences.
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Preface

INTRODUCTION

Healthcare is constantly changing so our brand 
needs to evolve too, to better represent who we 
are today and where we’re going tomorrow. 

As we continue to evolve, it’s more important  
than ever to look and sound like one Elixir.  
Clients, members, prospects even competitors 
should have a consistent experience with us.  
It starts with each one of us learning and  
embracing our purpose, promise and the  
language we use to bring it to life.

USING THIS GUIDE

This guide documents how we can protect our company’s 
identity by ensuring the use of visual elements consistently and 
structuring all messages to reflect an accurate vision of Elixir. 
This document provides guidance for instances when many 
possibilities exist to communicate the Elixir brand and offers 
clarity to both users of and designers for the Elixir brand.

CONTACT

If you have questions regarding the correct usage of the Elixir 
brand, please contact: AskMarketing@elixirsolutions.com
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Frequently Used Words

mailto:askmarketing%40elixirsolutions.com?subject=
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Associate: Use associate instead of employee, 
staff, etc. except if already used in the sentence

Caregiver: Instead of care giver

CMS Star Ratings: Capitalize Star Ratings and  
all instances of Stars. Use numerals with a point 
zero to refer to the actual rating 
Example: Elixir received a 3.0 Star Rating in 2020.

Co-insurance instead of coinsurance

Compound medications or compounded 
medications

Copay instead of co-pay or CoPay

Coworker instead of co-worker

Customer instead of patient

Frequently Used Words

Diabetic: Use person with diabetes rather  
than diabetic

Disability: Use instead of handicap

Email: All one word, lower case e, unless  
the start of a sentence, Not e-mail

Handicap: Never use handicap or  
handicapped. Use disability or disabled instead
Example: The building is disability accessible.

Healthcare instead of Health care

Health plan not healthplan 

Helpdesk instead of Help Desk

Homepage: All one word
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Industry best: Use to describe our technology 
platform instead of state-of-the-art 

Into vs in to: “Into” is a preposition that shows 
movement toward something or inside something. 
“In” is an adverb that is sometimes followed by 
to, but they are not related. Use “involved” or 
“interested in” instead of “into.”
Examples: 
“She put the letter into the envelope.”  
Not “She placed the letter in to the envelope.”

“I dropped in to say hello.”  
Not “I dropped into say hello.”

Login, logon, logoff: One word, no space, except 
when used as a verb 
Example: I log in to my computer.

Mail order: Two separate words, no hyphen,  
Not mail-order

Member: Use member instead of patient

Nonadherent/Nonadherence or non-adherent 
when modifying a noun
Examples:  
Nonadherence is a battle.
Non-adherent members are those who don’t 
take their medicine.

Noncompliance/Noncompliant or non-
compliance when modifying a noun

Online: All one word

Onsite: All one word
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Pharmacy Benefit Management (PBM)

Pharmacy & Therapeutics committee: Use  
the ampersand, capitalize Pharmacy and 
Therapeutics, lower case committee

Portal: When addressing any audience other  
than members, it is ok to say Member Portal  
and Mail Portal (always capitalized)

Products: Use solutions instead of products

Rx: It is ok to use Rx in headlines, subheads, 
taglines, tables, social media or other areas  
where space is limited. Do not use Rx in a 
sentence. 
Example: “He filled his prescription.”  
Not “He filled his Rx.”

Setup, set up, set-up: Use setup as one word 
when it is a noun, such as a trap for criminals,  
or an adjective, and use set up as two words 
when it is a verb. Do not hyphenate. 
Example: “The crime boss walked right into  
the setup” vs. “The judges still had to set up  
the chess board”

Signup, sign up, sign-up: Use signup as one 
word when it is a noun or an adjective and as 
two words when it is a verb. Do not hyphenate.
Example: “The signup form is on the table” vs. 
“Sign up for mail order today”

Solution(s): Use instead of products or 
programs. Capitalize solution when it is part  
of the proper name for a product or service
Example: Pain Management Solutions or 
Diabetes Management Solution.
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That vs. which: Use “that” if the words that follow 
are needed. Use “which” if the words that follow 
could be removed and the sentence would have 
the same meaning. There should always be a 
comma before which.
Example: “House Republicans scrambled Friday to 
finish work on a bill that will keep the government 
open beyond March 4th.”  
Not “House Republicans scrambled Friday to finish 
work on a bill, which will keep the government 
open beyond March 4th.”

“There was an earthquake in China, which is bad 
news.”  
Not “There was an earthquake in China,  
that is bad news.”

Toward: Instead of towards

Website: All one word
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INTRODUCTION

Healthcare is constantly changing so our brand 
needs to evolve too, to better represent who we 
are today and where we’re going tomorrow. 

As we continue to evolve, it’s more important  
than ever to look and sound like one Elixir.  
Clients, members, prospects even competitors 
should have a consistent experience with us.  
It starts with each one of us learning and  
embracing our purpose, promise and the  
language we use to bring it to life.

USING THIS GUIDE

This guide documents how we can protect our company’s 
identity by ensuring the use of visual elements consistently and 
structuring all messages to reflect an accurate vision of Elixir. 
This document provides guidance for instances when many 
possibilities exist to communicate the Elixir brand and offers 
clarity to both users of and designers for the Elixir brand.

CONTACT

If you have questions regarding the correct usage of the Elixir 
brand, please contact: AskMarketing@elixirsolutions.com
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Acronyms

ACA: Affordable Care Act

ACHC: Accreditation Commission for Healthcare. 
We have ACHC Specialty Pharmacy accreditation. 

ACO: Accountable Care Organization

AEP: Annual Enrollment Period. This is a time 
period from October to December (actual dates 
change each year) when Medicare beneficiaries 
must make coverage selections, either re-enrolling 
in their existing plan or enrolling in a new plan.

ANOC: Annual Notice of Change

ASO: Administrative Services Only

AWP: Average Wholesale Price. This is a cost  
for prescription medications.

BDA: Benefit Design Administration

BIN: Beneficiary Identification Number

BSF: Benefit Spec Form (term used internally  
for identifying a client’s plan design)

CDAG: Coverage Determinations, Appeals  
and Grievances

CMR: Comprehensive Medication Review

CMS: Centers for Medicare and Medicaid 
Services

COB: Coordination of Benefits

DAW: Dispense as Written. This is a set of 
instructions that can be written on a prescription 
that tells the pharmacist not to substitute 
generic or other alternative.

DEA: Drug Enforcement Administration
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Acronyms

DME: Durable Medical Equipment

DUR: Drug Utilization Review. This is an analysis  
of the medications a member is taking.

EGWP: Employer Group Waiver Plan

EOB: Explanation of Benefits. This is a statement 
sent to members that describes the medications 
they received and how they were covered under 
their prescription benefit plan.

EOC: Evidence of Coverage

EOY: End of Year

ER: Emergency Room

FDA: Food and Drug Administration

FDR: First Tier, Downstream and Related Entity

FWA: Fraud, Waste and Abuse

HIPAA: Health Insurance Portability and 
Accountability Act

KPI: Key Performance Indicator

LTC: Long-Term Care

MA: Medicare Advantage. A type of  
Medicare plan.

MAC: Maximum Allowable Cost

MAPD: Medicare Advantage Prescription  
Drug Plan

MCO: Managed Care Organization

Medicare Part A: Hospital Insurance

Medicare Part B: Medical Insurance
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Medicare Part D: Prescription Drug Insurance

MTM: Medication Therapy Management

NABP: National Association of Boards of Pharmacy. 
This accrediting organization requires a registered 
trade mark be used after both the full name and 
the acronym, even when using both: National 
Association of Boards of Pharmacy® (NABP®). We 
have a Digital Pharmacy Accreditation from NABP.

NCQA: National Committee for Quality Assurance. 
We have Accreditation in Utilization Management 
and Health Information Products Certification for 
Pharmacy Benefits Information from NCQA.

NCPDP: National Council for Prescription Drug 
Programs

NDC: National Drug Code. All prescription 
medications approved by the FDA have an  
NDC number.

NPI: National Provider Identification

OON: Out of Network. This refers to when a 
member fills a prescription at a pharmacy that  
is not in our network.

OOP: Out of Pocket. This refers to the costs  
that the member incurs that are not covered by 
the prescription benefit, such as their copay.

OTC: Over the Counter, or a drug available 
without a prescription.

PA: Prior Authorization. Some medications 
require an authorization from the member’s 
doctor before the prescription will be covered 
by the plan.
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PALs: Pharmacy Advisory Leaders. Typically  
these are key leaders at consulting firms.

PBM: Pharmacy Benefit Manager

PCN: Prescription Processor Control Number

PDE: Prescription Drug Event

PDP: Prescription Drug Plan. This term refers  
to Medicare prescription drug plans, such as  
the ones offered by Elixir Insurance.

PHI: Personal Health Information

PII: Personally Identifiable Information

PMO: Project Management Office

PMPM: Per Member Per Month

PMPY: Per Member Per Year

POS: Point of Sale. This is where a customer 
pays for a product.

P&T: Pharmacy & Therapeutics committee

QBR: Quarterly Business Review. 

REMS: Risk Evaluation and Mitigation Strategy

RFP: Request for Proposal. 

SME: Subject Matter Expert. This is a person 
that can be contacted for additional information 
on a particular subject.

TMR: Targeted Medication Review

TPA: Third-Party Administrator. These are 
organizations that manage insurance benefits 
for companies.
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TROOP or TrOOP: True Out-of-Pocket cost/
expense

U&C: Usual & Customary. This is the price that a 
customer pays for a drug at the pharmacy.

UM: Utilization Management. There are a variety 
of UM strategies, such as quantity limits and step 
therapy that can be applied to control costs and 
ensure members are taking the right medication  
for their condition and are taking it safely.

URAC: This accrediting organization does 
not use its full name. Always use the acronym 
only. We have URAC accreditations in 
Pharmacy Benefit Management, Drug Therapy 
Management, Specialty Pharmacy and Mail 
Service Pharmacy.

WAC: Wholesale Acquisition Cost
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are today and where we’re going tomorrow. 

As we continue to evolve, it’s more important  
than ever to look and sound like one Elixir.  
Clients, members, prospects even competitors 
should have a consistent experience with us.  
It starts with each one of us learning and  
embracing our purpose, promise and the  
language we use to bring it to life.

USING THIS GUIDE

This guide documents how we can protect our company’s 
identity by ensuring the use of visual elements consistently and 
structuring all messages to reflect an accurate vision of Elixir. 
This document provides guidance for instances when many 
possibilities exist to communicate the Elixir brand and offers 
clarity to both users of and designers for the Elixir brand.

CONTACT

If you have questions regarding the correct usage of the Elixir 
brand, please contact: AskMarketing@elixirsolutions.com
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A variety of language exists to protect the company, our members and consumers, and 
our information. Depending on the content created, all forms should have one of these 
marks unless the content is for public distribution. Confidentiality marks help us ensure 
we share and protect our information correctly.

Privacy Marks

For content shared with outside parties containing  
pricing or other sensitive business information 
typically clients, prospects, vendors, brokers, etc.

CONFIDENTIAL – Do not copy or distribute.

For materials without sensitive information that has 
been created or approved for public distribution 
without any mark or disclaimer. Typically content  
like marketing materials, job postings, etc.

For all content used internally ONLY.

RESTRICTED – Not for external distribution.

For all content used both internally and externally. 
“Elixir” should be used on all copyright statements 
—even if in a different line of business document.

© 2023 Elixir Rx Solutions, LLC - All Rights Reserved.

CONFIDENTIAL UNRESTRICTED

RESTRICTED COPYRIGHT
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Privacy Marks

PRIVACY BEST PRACTICES

All confidential and restricted material 
requires the use of a disclaimer.

Font should be 7 point (minimum),  
Arial Narrow (no italics, no bold). 

Mark should be placed in a 
conspicuous location (e.g., footer/ 

header) on the document.

Privacy stamps already exist in  
template toolkit assets so you don’t 

have to create separately.
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Preface

INTRODUCTION

Healthcare is constantly changing so our brand 
needs to evolve too, to better represent who we 
are today and where we’re going tomorrow. 

As we continue to evolve, it’s more important  
than ever to look and sound like one Elixir.  
Clients, members, prospects even competitors 
should have a consistent experience with us.  
It starts with each one of us learning and  
embracing our purpose, promise and the  
language we use to bring it to life.

USING THIS GUIDE

This guide documents how we can protect our company’s 
identity by ensuring the use of visual elements consistently and 
structuring all messages to reflect an accurate vision of Elixir. 
This document provides guidance for instances when many 
possibilities exist to communicate the Elixir brand and offers 
clarity to both users of and designers for the Elixir brand.

CONTACT

If you have questions regarding the correct usage of the Elixir 
brand, please contact: AskMarketing@elixirsolutions.com
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Digital

mailto:askmarketing%40elixirsolutions.com?subject=
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Elixir has an online presence which include websites, blogs and social media accounts to 
stay connected to our clients, members and partners. 

Digital

elixirsolutions.com

elixirinsurance.com

elixirsavings.com

Learn more ways to improve 
patient and plan outcomes 
with our blog:
blog.elixirsolutions.com

LinkedIn:
linkedin.com/company/ 
elixir-craftedrxsolutions

Twitter: @ElixirPBM

WEBSITES BLOG SOCIAL MEDIA

mailto:https://www.elixirsolutions.com/?subject=
https://elixirinsurance.com/
https://savings.elixirsolutions.com/
mailto:https://blog.elixirsolutions.com/?subject=
https://lwww.linkedin.com/company/
elixir-craftedrxsolutions
https://lwww.linkedin.com/company/
elixir-craftedrxsolutions
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DIGITAL STYLE GUIDE

Our digital style guide is a one-stop place 
to see all visual styles of the site such 
as headers, links, buttons, color palettes 
and any visual language that is used on 
our web and digital assets. For access 
to this site, please contact marketing at 
AskMarketing@elixirsolutions.com.

Digital

mailto:askmarketing%40elixirsolutions.com?subject=Digital%20Style%20Guide
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ACKNOWLEDGMENT OF REQUIREMENTS
All employees are required to read our Brand 
Guidelines and follow its standards as well as 
Elixir policies and practices.

ELIXIR MAILING ADDRESS:

7835 Freedom Ave. NW, North Canton, OH 44720 
800-361-4542
© 2023 Elixir Rx Solutions, LLC - All Rights Reserved.  22-7187

QUESTIONS?
Contact the Marketing Department at  
AskMarketing@elixirsolutions.com

UPDATES TO THE BRAND GUIDELINES
Periodic updates will be made to the Brand 
Guidelines. Download the most up-to-date 
version in our Asset Library.

mailto:askmarketing%40elixirsolutions.com?subject=
mailto:askmarketing%40elixirsolutions.com?subject=
http://elixir.info/library

